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Introduction to Reports 1

To provide for more effective Contact Center Management, CCA lets 
you create tabular and graphical reports to help you understand the 
trends, activities, and Agent performance in your call center. These 
reports would include:

• Agent activity, performance, and efficiency
• Interaction statistics
• Interaction outcomes
• Project billing and cost details
• Outcome of Predictive calls

CCA reports are customizable, so you can:

• Display as much or as little data as needed.
• Specify the date range to report on.
• Display data in the graphical format that makes the most sense to 

you.
• Control which Administrators and Supervisors can access reports.
• Specify the date format, time zone, and language for the report.
• Schedule reports to be run automatically
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Overview of Reports
The Administration Manager allows for the generation of two types of 
reports; Standard and Advanced Reports.See the individual report 
chapters for information on generating a particular report.

Table 1-1Standard Administration Manager Reports

Report Description

Weekly Project 
Routing Schedule

Lists all of the Schedules you have defined for your call 
center.

Workgroup Skills Displays the skills assigned to a Workgroup and the 
rating of those skills

Billing Summarizes the number and duration of interactions in 
each call center for which you provide service.

Workgroup Key 
Statistics

Shows statistics that help you understand the overall 
performance of your call center.

Workgroup Interval 
Time

Shows how your Agents are performing at specific times 
of the day.

Workgroup Interval 
Time by Media

Shows how many Interactions of each media type your 
call center receives at specific times of the day)

Outcome Statistics Allows you to track the results of Interactions based on 
Interaction Type (ACD Call, Web Callback, and so on).

Overdue Callbacks Lists all waiting Web call-back Interactions.

Predictive Dialer 
Totals

Shows a group of call related statistics (number of calls, 
answer rate, and so on) for predictive dialing.

Predictive 
Productivity

Displays a breakdown of the production statistics based 
on the agents used for any or all Predictive call 
attempts. Note: Predictive Reports are available only if 
you have purchased Predictive Dialing capabilities with 
your version of CCA.

Predictive 
Summary

Displays a breakdown of the actions (left message, 
callback, and so on) of all Predictive call attempts. Note: 
Predictive Reports are available only if you have 
purchased Predictive Dialing capabilities with your 
version of CCA.
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Predictive Detailed Displays a breakdown of the results (busy, no answer, 
and so on) of all Predictive call attempts. Note: 
Predictive Reports are available only if you have 
purchased Predictive Dialing capabilities with your 
version of CCA.

Preview Summary Displays a breakdown of the preview results based on 
the agents used for any or all Predictive call attempts. 
Note: Preview Reports are available only if you have 
purchased Preview Dialing capabilities with your version 
of CCA.

Agent Information Displays profile information (extension, email address, 
and so on) for Agents.

Agent Interaction Displays details about number and duration of the 
selected Interaction type for the selected Agents.

Agent Skills Lists all the Skills defined for your Company, and 
indicates which Agents possess that skill and their rating 
for the skill. Quickly shows you which Agents possess 
each skill in your call center.

Agent Utilization Lets you analyze Agent usage by showing the amount 
of time each Agent spent handling Interactions, awaiting 
Interactions, or on break.

Direct Dialing 
Statistics

Show statistics for calls dialed directly to Agents or 
dialed by Agents to external numbers.

Login by Groups of 
Users

Displays the Agents who logged in, login time, and login 
duration.

Login by User Provides information about the Login activity of each of 
your CCA Agents.

Project Key 
Statistics

Shows a set of interaction statistics, broken down by 
interaction type (phone, email, and so on), and as a 
summary across all interaction types.

Table 1-1Standard Administration Manager Reports

Report Description
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Viewing and Printing Reports
You can view and print reports that you or another Administrator have 
created and saved for your company.

Note
CCA Supervisors cannot create or edit report definitions. If you are a 
Supervisor and need a new report, or would like changes to an existing 
report, please contact your Administrator.

Table 1-2 Advanced Reporting Templates

Report Description

Project Performance Tracks Project activity related to asa/aba 
levels, Talktime and Service Levels

Workgroup 
Performance

Tracks Workgroup call activity, total 
Workgroup ACD status time, and total 
number of agents logged in by an 
administrator-set interval.

User Login/Logout Tracks Agent login/logout activity by date, 
time, event and reason.

Average Calls Per Hour Tracks Individual Agent call activity by 
Average Calls per hour, and ACD status 
time.

User Performance Tracks individual Agent performance by 
time in ACD status, Call Counts/Call Types 
and Talk Time.

Peak Interactions Tracks peak interactions at pre-set 
intervals by Company.

System Peak 
Interactions

Tracks peak interactions at pre-set 
intervals by Company at a system level.

Interaction Outcome Tracks Interactions by outcome, number 
of Interactions per outcomeduration and 
average duration.
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To view or print reports:

1. Expand the Reports links in the Navigation Pane, then expand one 
of the bold headings to see the reports under that heading.

2. Click on a report name (for example, the Billing report). If no 
reports of that type have been created, you will see an empty 
report list.

Figure 1-1 Example Empty Report List

Figure 1-1. Example Empty Report List

3. If any reports of that type have been created, you can view the 
report by right-clicking on it and choosing View from the popup 
menu, or you can click the View button at the top of the screen.

Figure 1-2 View 

Figure 1-2. View

4. After you click View, the Report dialog box appears.
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Figure 1-3 Report Dialog Box: Period Covered Tab

Figure 1-3. Report Dialog Box: Period Covered Tab

5. If it is available for the report type you selected, use the Period 
Covered tab to set the date range for your report

Field Description

Start Date Click  to display a calendar from which you can choose the 
starting date of the report range. Click ‘>’ or ‘<‘ to advance or roll 
back the calendar one month, respectively. Click ‘>>’ or ‘<<‘ to 
advance or roll back the calendar one year, respectively. 
Choose the report start date by clicking a day in the calendar, or 
click today to choose today’s date (based on your workstation’s 
system clock).

End Date Click  to display a calendar from which you can choose the 
ending date of the report range. Click ‘>’ or ‘<‘ to advance or roll 
back the calendar one month, respectively. Click ‘>>’ or ‘<<‘ to 
advance or roll back the calendar one year, respectively. 
Choose the report end date by clicking a day in the calendar, or 
click today to choose today’s date (based on your workstation’s 
system clock).
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6. Click the Regional Option.tab.

Figure 1-4 Report Dialog Box: Regional Options Tab

Figure 1-4. Report Dialog Box: Regional Options Tab

7. Complete the Regional Options tab.

Start Time Choose the starting hour (24-hour notation) and minute of your 
report range.

End Time Choose the ending hour (24-hour notation) and minute of your 
report range.

Field Description

Display Time Choose Company Default Time Zone to display 
all report times in the time zone that has been 
defined as the default for your Company. Choose 
User Time Zone to display all report times in the 
time zone that you have configured for your 
Administration Manager workstation.

Field Description
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8. Click OK.

The report will appear in a browser window. Use your browser’s 
Print command to print the report.

A Note About Start and End Times
For almost every report, the start and end times work in the same 
way. For example, let’s say you are running a Billing report. 

You select: 

• 07/01/04 as the start date.
• 07/30/04 as the end date. 
• 8:00 (AM) as the start time.
• 17:00 (5:00 pm) as the end time.

Your report will include events:

• starting at 8:00 AM on 7/01/04 
• through 5:00 PM on 07/30/04. 

Any event that occurred between those times, twenty-four hours a 
day, seven days a week, will be included in your report. And every CCA 
report works this way -- with two exceptions:

• The Workgroup Interval Time report
• The Workgroup Interval Time by Media report

If you run these reports, and select the same start and end times that 
we mentioned above, your report would contain events that occurred 
between 8:00 AM and 5:00 PM, every day between 07/01/04 and 
07/30/04.

Report Language Choose the language to display in this report.

Select Date Format to 
Display in Report

Choose Company Default Date Format to display 
all report dates in the format that has been defined 
as the default for your Company. Choose User 
Defined Date Format to display all report dates in 
the format that you have configured for your 
Administration Manager workstation.

Field Description
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Scheduling Reports
You can use the View button to manually generate a report whenever 
you want (see page 1-4). However, you can also schedule reports to 
run automatically, cover selected periods of time, and be automatically 
mailed to one or more email addresses.

All scheduled reports are generated at midnight according to the 
company itemizing.

Note: Before you can use the scheduling feature for the first time, you 
must make some minor edits to the report.xml file. See “Configuring 
the report.xml File” on page D-9. 

To Schedule a Report

1. Select a report type. For example:

Reports > Call Center Operations > Workgroup Skills

2. Click the Add button if you are creating a new report, or the Edit 
button to create a schedule for an existing report. 

3. When the report opens, click on the Schedule Report tab; then 
select the Enable Report Scheduling check box.
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Figure 1-5 Schedule a Report

Figure 1-5. Schedule a Report

4. Select a reporting period:

• Daily
• Weekly
• Monthly

5. Fill out the fields under Send this Report by Email. 

• In the To textbox, enter one or more email addresses where 
you want the report to be sent. Separate multiple email 
addresses with a semi-colon “;”. For example: 

brice@indy500.com;gdefarran@indy500.com

You can enter a maximum of 2048 characters in the To field.

• In the From textbox, enter one email address. The person who 
receives the report will see this address in the email’s From 
field.
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You can enter a maximum of 128 characters in the To field.

6. Select an SMTP group.

Deleting a Report
The steps below show how to delete a Workgroup Key Statistics report, 
but all reports are deleted the same way.

1. Click on the Reports link to expand it, then click on a report group 
name (such as Call Center Operations) to see the reports in that 
group.

Figure 1-6 Reports Links

Figure 1-6. Reports Links

2. Click on one of the report name, such as Workgroup Key 
Statistics. A list of reports of that type will appear. 

Figure 1-7 Workgroup Key Statistics

Figure 1-7. Workgroup Key Statistics

3. Right-click on the report that you want to delete and select Delete 
from the popup menu. 

You can also select a report and then click the Delete button.

4. Click OK confirm the deletion.

Click to
Expand
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Deleted Objects and Historical Reports
Although Administration Manager allows you to create and delete many 
“objects” such as companies, Workgroups, Agents, Projects, Data 
Sources, and so on, deleting an object from Administration Manager 
does not delete the object from the CCA database. For example, if you 
delete a Workgroup in Administration Manager, the Workgroup is still in 
the database, it is just marked as “do not display this Workgroup in 
any CCA GUI”.

Because objects remain in the database forever, they can be picked up 
by reports that contain historical data. If you delete a Workgroup on 
January 15th, and then run a report that shows Workgroup activity 
going back to January 1st, the report will show activity from the 
deleted Workgroup.
1-12 CallCenterAnywhereTM Administration Manager



2

The Call Center Operations 
Reports 2

Weekly Project Routing Schedules Report
The Weekly Project Routing Schedules Report lists all of the 
Schedules you have defined for your call center.

Figure 2-1 Weekly Project Routing Schedules Report

Figure 2-1. Weekly Project Routing Schedules Report
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Report Elements

The Weekly Project Routing Schedules Report shows the following 
information for each schedule:

Creating a Weekly Project Routing Schedules Report

1. Click Reports > Call Center Operations > Weekly Project 
Routing Schedules. 

2. Click Add.

Table 2-1Project Schedules Report Columns

Column Description

DNIS The telephone number or email 
address that customers use to 
reach the Scheduled Project

Day The day the number or address 
indicated by DNIS is scheduled to 
run.

Start Time The time (24-hour clock) on the 
indicated Day the Project is 
scheduled to start.

From Project The Project that the schedule 
temporarily disables while the To 
Project runs.

To Project The Project the schedule runs at 
the indicated Day and Start Time.

TIme Zone The time zone used to generate the 
report. The values in the Start Time 
column are for this time zone.
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Figure 2-2 Add Report Definition: Name Tab

Figure 2-2. Add Report Definition: Name Tab

3. Complete the Name tab for your Weekly Project Routing Schedules 
Report.

4. Click Content.

Table 2-2

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Weekly Project 
Routing Schedules Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Weekly Project Routing Schedules Report 
definitions.
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Figure 2-3 Weekly Project Routing Schedules Report: Content Tab

Figure 2-3. Weekly Project Routing Schedules Report: Content Tab

5. Complete the Content tab.

6. Click Layout.

Table 2-3

Field Description

Include Statistics 
On

Check the days of the week to include in 
the report in the Include Statistics On 
area. Click All to include all days, or click 
Clear to clear all the check boxes.
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Figure 2-4 Weekly Project Routing Schedules Report: Layout Tab

Figure 2-4. Weekly Project Routing Schedules Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 2-4

Field Description

Build Report Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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Figure 2-5 Add Report Definition: Regional Options Tab

Figure 2-5. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 2-5

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 2-6 Add Report Definition: Permissions Tab

Figure 2-6. Add Report Definition: Permissions Tab

11. Click the check box next to a Supervisor to give them permission 
to view and print the report. Supervisors you do not check will not 
see the report in Supervision Manager. Click All to include the 
entire list, or click Clear to clear all selections.

12. Click OK.

CCA saves your report in the database for access by any 
Administrator or Supervisor who is logged into your Company and 
to whom you have given permission to access the report. 

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Workgroup Skills Report
The Workgroup Skills Report displays the skills assigned to a 
Workgroup and the rating of those skills.
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Figure 2-7 Sample Workgroup Skills Report 

Figure 2-7. Sample Workgroup Skills Report

Report Elements

Note
CCA Supervisors viewing the Workgroup Skills Report should bear in 
mind that this report reflects activity for the entire Company. Data 
presented includes all Agents, not just the Agents you supervise.
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Creating a Workgroup Skills Report

1. Click Reports > Call Center Operations > Workgroup Skills. 

2. Click Add.

Figure 2-8 Add Report Definition: Name Tab

Figure 2-8. Add Report Definition: Name Tab

Table 2-6Workgroup Skills Report Fields

Item Description

Skill Name The Skill Name you entered when 
you created the skill (Options > 
Skills). 

Rating The Skill Level Weight you 
assigned to this skill when you 
created the Workgroup (Options > 
Workgroups > Skills).
The Call Center Operations Reports 2-9



3. Enter a Report Name and Description for your report.

4. Click Content.

Figure 2-9 Workgroup Skills Report: Content Tab

Figure 2-9. Workgroup Skills Report: Content Tab

5. Complete the Content tab.

Select the Workgroups that you would like to appear in the report.

6. Click Regional Options.

Table 2-7

Field Description

Report 
Name

The report name will appear on each page of the report and in 
the Name column of the list of Workgroup Skills Report 
definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Workgroup Skills Report definitions.
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Figure 2-10 Add Report Definition: Regional Options Tab

Figure 2-10. Add Report Definition: Regional Options Tab

7. Complete the Regional Options tab.

8. Click Permissions.

Table 2-8

Choose... To display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
Company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language you choose.

Company Default 
Date Format

All dates will be formatted using the format set for the 
Company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 2-11 Add Report Definition: Permissions Tab

Figure 2-11. Add Report Definition: Permissions Tab

9. Click on the Any Supervisor radio button to give all Supervisors 
access to your report. Click on The Following Supervisors to 
select supervisors from a list.

10. Click OK or Apply. 

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Billing Report
The Billing Report (Service Provider Edition only) summarizes the 
number and duration of interactions in each call center for which you 
provide service.
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Figure 2-12 Sample Billing Report 

Figure 2-12. Sample Billing Report

Report Elements

Creating a Billing Report

1. Click Reports > Call Center Operations > Billing. 

2. Click Add.

Table 2-9Billing Report Fields

Item Description

Call Center The name of the call center 
for which you provide 
service.

Number of 
Interactions

The total number of 
interactions processed by 
that call center for the time 
period covered by the report. 

Duration of 
Interactions

The total amount of time that 
the call center spent 
processing those 
interactions. 
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Figure 2-13 Add Report Definition: Name Tab

Figure 2-13. Add Report Definition: Name Tab

3. Enter a Report Name and Description for your report.

4. Click Regional Options.

Table 2-10

Field Description

Report 
Name

The report name will appear on each page of the report and in 
the Name column of the list of Billing Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Billing Report definitions.
2-14 CallCenterAnywhereTM Administration Manager



Figure 2-14 Add Report Definition: Regional Options Tab

Figure 2-14. Add Report Definition: Regional Options Tab

5. Complete the Regional Options tab.

6. Click OK or Apply. 

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Table 2-11

Choose... To display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
Company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language you choose.

Company Default 
Date Format

All dates will be formatted using the format set for the 
Company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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3

The Workgroup Productivity 
Reports 3

Workgroup Segments Report
The Workgroup Key Statistics Report shows call center usage, 
Agent performance, and billing statistics for the Projects and 
Workgroups that you select. 

Interactions which were routed to Workgroup Agents by the Automatic 
Call Distribution system are included in this report. Calls made directly 
to an Agent, or outbound calls made by an Agent, are not included in 
this report. 

This report tracks the number of “steps” that a caller took in the 
Workgroup prior to terminating the call. These steps would include 
transfers and overflows to and from other Workgroups.
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Figure 3-1 A Workgroup Key Statistics Report

Figure 3-1. A Workgroup Key Statistics Report

Report Elements

The following sections describe each element included in the following 
areas of the Workgroup Segment Report:

• Segment Events
• Abandoned Interval
• Agent Answered Interval
• Media Type Segments Handled
• Agent Segment Processing
• Summary
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Note
Supervisors should remember that this report includes activity for all 
Agents in the selected Project or Workgroup, not just the Agents that 
they supervise.

Segment Events

The Segment Events area shows information for the Interactions 
received by the call center.

Table 3-1 Segment Events

Item Description Table/Field

Agent 
Answered 

Number of Workgroup 
Interactions routed to and 
accepted by Agents.

ReportsCallCenterKey
HistoryActions
HasACDCalls
HasACDCallback
HasWebCB
HasVoicemail
HasChat
HasEmail
HasFax

Abandoned Number of Workgroup 
Interactions received by the 
call center but abandoned by 
the customer before being 
accepted by an Agent.

ReportsCallCenterKey
HistoryActions
timetoabandoned

Callback Calls Number of Callback and Web 
Callback Interactions handled 
by the call center.

ReportsCallCenterKey
HistoryActions
HasACDCallback
HasACDCalls

Voicemail Number of calls in which the 
caller left a voicemail 
message for a Workgroup 
Agent rather than wait in the 
queue to be connected to an 
Agent.

ReportsCallCenterKey
HistoryActions
HasVoicemail

Other 
Workgroups

Number of calls transferred 
into Workgroup from other 
Workgroups

ReportsCallCenterKey
HistoryActions
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Time to Abandoned Interaction

The Time to Abandoned Interactions area shows statistics for the 
length of time that customers waited before deciding to abandon their 
attempt to reach your call center.

No Answer Number of Calls presented to 
Agent that went to “No 
Answer” state and were 
transferred to another Agent

ReportsCallCenterKey
HistoryActions

Other Events

Total Segments 
Received

Sum of all Interaction 
segments received by the 
Workgroup during reporting 
interval

ReportsCallCenterKey
HistoryActions

Table 3-2 Time to Abandoned Interactions

Item Description Table/Field

under 0 min 
30 Seconds

Number of Interactions abandoned 
in under 30 seconds

HistoryActions
ActionId
Duration

0 min 31 
sec to 1 min 
0 sec

Number of Interactions abandoned 
after waiting 30 seconds, but in 
under 60 seconds.

HistoryActions
ActionId
Duration

1 min 1 sec 
to 1 min 30 
sec

Number of Interactions abandoned 
after waiting 61 seconds, but in 
under 1 minute and 30 seconds.

HistoryActions
ActionId
Duration

1 min 31 
sec to 2 min

Number of Interactions abandoned 
after waiting between 1 minute and 
30 seconds and 2 minutes.

HistoryActions
ActionId
Duration

Over 2 min 
0 sec

Number of Interactions abandoned 
after waiting more than 2 minutes.

HistoryActions
ActionId
Duration

Table 3-1 Segment Events

Item Description Table/Field
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Agent Answered Interval 

The Agent Answered Interval area shows statistics for the length of 
time customers waited before being connected to an Agent.

Table 3-3 Agent Answered Interval

Item Description Table/Field

Below Threshold 1 Total number of Interaction 
segments that were accepted by 
an Agent before expiration of the 
time limit you supplied for 
Threshold 1 in the Content tab of 
the report definition.

HistoryActions
ReportsCallCenterKey
CallThreshold1
CallbackThreshold1
WebCallbackThreshold1
FaxesThreshold1
EMailThreshold1
ChatThreshold1

Below Threshold 2 Total number of Interactions 
segments that were accepted by 
an Agent before expiration of the 
time limit you supplied for 
Threshold 2 in the Content tab of 
the report definition.

HistoryActions
ReportsCallCenterKey
CallThreshold2
CallbackThreshold2
WebCallbackThreshold2
FaxesThreshold2
EMailThreshold2
ChatThreshold2

Greater than 
Threshold 2

Total number of Interaction 
segments that were accepted by 
an Agent after expiration of the 
time than the value you supplied 
for Threshold 1 in the Content tab 
of the report definition.

HistoryActions
ReportsCallCenterKey
CallThreshold2
CallbackThreshold2
WebCallbackThreshold2
FaxesThreshold2
EMailThreshold2
ChatThreshold2

Total Segments 
Answered

Total number of Interaction 
segments routed to and accepted 
by Workgroup Agents. 
Direct-dialed calls are not 
included in this report. (See 
“Direct Dialing Statistics Reports” 
on page 18-25.for information on 
direct-dialed calls).

ReportsCallCenterKey
HistoryActions
HasACDCalls
HasACDCallback
HasWebCB
HasVoicemail
HasChat
HasEmail
HasFax
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Media Type Segments Handled

The Media Type Segments Handled area shows the number of 
Interactions of each media type handled by the selected Projects or 
Workgroups. This information is displayed as a total and a percentage 
against the total number of Interaction Segments received. Statistics 
reflect only those Interaction Types you choose to display from the 
Include Statistics On area of the Content tab.

Table 3-4 Media Type Segments Handled

Item Description Table/Field

Workgroup 
Calls

Number and percentage of Interactions that 
reached the call center by Phone, were 
routed to a Workgroup, and subsequently 
handled by an Agent. Includes Phone calls, 
Predictive calls, and Preview calls.

ReportsCallCenterKey
HistoryActions

Workgroup 
Voicemail

Number and percentage of Interactions that 
reached the call center by Phone, were 
routed to a Workgroup, and elected to 
leave a voicemail message rather than wait 
in the Workgroup queue for an Agent.

ReportsCallCenterKey
HistoryActions

 Callback Number and percentage of Interaction who 
reached the call center by Phone, were 
routed to a Workgroup, and requested a 
call-back rather than wait in the Workgroup 
queue for an Agent.

ReportsCallCenterKey
HistoryActions

Web 
Callback

Number and percentage of customers who 
reached the call center by requesting a 
callback from an Agent using your Web 
site.

ReportsCallCenterKey
HistoryActions

Chat Number and percentage of customers who 
reached the call center by requesting a 
chat with an Agent using your Web site.

ReportsCallCenterKey
HistoryActions

Workgroup 
Email

Number and percentage of Interactions that 
reached the call center by email, were 
routed to a Workgroup, and subsequently 
handled by an Agent.

ReportsCallCenterKey
HistoryActions

Workgroup 
Fax

Number and percentage of fax Interactions 
that were routed to a Workgroup and 
subsequently handled by an Agent.

ReportsCallCenterKey
HistoryActions
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Agent Segment Processing

The Agent Segment Processing area shows the average length of 
time Agents spent in various phases of the Interaction. Note: Agent 

Talk Time includes call hold time.

Table 3-5 Agent Segment Processing

Item Description Table/Field

Average Speed 
of Answer

Average length of time segments 
were answered by Agents.

ReportsCallCenterKey
HistoryActions

Average Talk 
Time

Average length of time that Agent 
spent talking to Caller. Talk Time 
includes time Caller spent “on hold”. 
Calculation = Total Talk Time + Total 
Hold Time/Total Number of 
Segments

ReportsCallCenterKey
HistoryActions

Average Wrap 
Up Time

The Average amount of time spent 
by an Agent in Wrap Up State. 
Calculation = Total Wrap Time/Total 
Number of Segments

ReportsCallCenterKey
HistoryActions

Average 
Handle Time 
per Segment

Average length of time that it took to 
Handle an Interaction. Calculation 
includes Total Talk Time + Total Hold 
Time+ Total Wrap Time/Number of 
Segments

ReportsCallCenterKey
HistoryActions

Average Hold 
Time

Average length of time Agents spent 
on Hold. Calculation = Total hold 
Time/Total Segments

ReportsCallCenterKey
HistoryActions
The Workgroup Productivity Reports 3-7



Summary

The Summary area shows overview data for Interactions received, 
and for Interaction wait times.

Table 3-6 Summary

Item Descriptions Table/Field

Total Segments 
Received

Total number of Segments 
received by Workgroup.

ReportsCallCenterKey
HistoryActions

Total Segments 
Answered by 
Agent

Total number of Segments 
received by CCA, routed to a 
Workgroup, and handled by 
an Agent.

ReportsCallCenterKey
HistoryActions

Number of Times 
Segments Went to 
Hold

Total number of voice 
segments placed on Hold at 
any time by an Agent.

ReportsCallCenterKey
HistoryActions

Duration of 
handled 
Segments

Total time Interactions spent 
in the system. Calculated as 
the difference between the 
time the Interaction was 
received by CCA and the 
conclusion of the Interaction.

ReportsCallCenterKey
HistoryActions

Shortest Wait to 
Answer

Length of time the Interaction 
with the shortest queue time 
waiting for an Agent.

ReportsCallCenterKey
HistoryActions

Longest Wait to 
Answer

Length of time the Interaction 
with the longest queue time 
waiting for an Agent.

ReportsCallCenterKey
HistoryActions

Average Ring 
Time

Average Time between time 
segment presented to Agent 
and Agent Answer. 
Calculation= Total Ring 
Time/Total Segments

ReportsCallCenterKey
HistoryActions

Average Time to 
Abandoned

Average length of time Caller 
spent prior to terminating call 
prior to being routed to Agent

ReportsCallCenterKey
HistoryActions

OverFlow In Total Number of Segements 
received by Workgroup as a 
result of being overflowed 
from another Workgroup.

ReportsCallCenterKey
HistoryActions
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Creating a WorkgroupSegments Report

1. Click Reports > Workgroup Productivity > Workgroup 
Segments.

2. Click the Add button.

Figure 3-2 Add Report Definition: Name Tab

Figure 3-2. Add Report Definition: Name Tab

OverFlow Out Total Number of Segments 
that were not answered by 
Workgroup Agent and 
tranferred out.

ReportsCallCenterKey
HistoryActions

Transferred In Total Number of Segments 
that were received as 
transfers.

ReportsCallCenterKey
HistoryActions

Table 3-6 Summary

Item Descriptions Table/Field
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• Complete the fields in the Name tab.

3. Click the Content tab.

Figure 3-3 Workgroup Segments Report: Content Tab

Figure 3-3. Workgroup Key Statistics Report: Content Tab

Table 3-7

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Workgroup Key 
Statistics Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Workgroup Key Statistics Report definitions.
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4. Complete the Content tab.

5. Click the Regional Options tab. 

Table 3-8

Field Description

Include 
Statistics On

Check the Interaction Types to include in the report in the 
Include Statistics On area. Click All to include all Interaction 
Types, or click Clear to clear all the check boxes.

Threshold 1 For each Interaction Type you checked, choose a length of 
time against which Agent performance for that Interaction Type 
is measured. For example, if you enter a value of 1 minute for 
Threshold 1, the Workgroup Key Statistics Report shows the 
number and percentage of Interactions accepted before the 
customer had waited 1 minute in the queue.

Threshold 2 For each Interaction Type you checked, choose a length of 
time against which Agent performance for that Interaction Type 
is measured. For example, if you enter a value of 5 minutes for 
Threshold 2, the Workgroup Key Statistics Report shows the 
number and percentage of Interactions accepted before the 
customer had waited 5 minutes in the queue, as well as the 
number of Interactions accepted after the customer had waited 
5 minutes in the queue.

Using Data 
Source

Click the Projects check box and then select one or all of your 
Projects. 

Click the Workgroups check box and then select one or all of 
your Projects. 
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Figure 3-4 Add Report Definition: Regional Options Tab

Figure 3-4. Add Report Definition: Regional Options Tab

6. Complete the Regional Options tab.

7. Click Permissions.

Table 3-9

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 3-5 Add Report Definition: Permissions Tab

Figure 3-5. Add Report Definition: Permissions Tab

8. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

9. Click OK.

• See page 14-3 for information about viewing and printing a 
report. Also, selecting a Start and End time for this report is 
slightly different than for other reports. See “A Note About 
Start and End Times” on page 14-7.

• See page 14-10 for information about deleting a report.
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Workgroup Interval Time Report
The Workgroup Interval Time Report shows how your Agents are 
performing at specific times of the day. You can report on time 
intervals as short as 1 minute and as long as 60 minutes. The example 
below shows an Workgroup Interval Time Report created to display 
intervals of 60 minutes.

Figure 3-6 Workgroup Interval Report

Figure 3-6. Workgroup Interval Report

Report Elements
Each row of the report shows a single time interval based on the value 
you entered for Set Threshold Times on the Content tab. 
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Table 3-10 describes the contents of each column of the Workgroup 
Interval Time Report.

Table 3-10Workgroup Interval Time Report Columns (Part 1 of 2)

Column Description Table/Field

Interval The time span to report on in each row 
of the report. You can set the length for 
each interval in the Set Interval field on 
the Content tab when creating the report 
definition.

The total number of rows in the report is 
based on your specified Interval Time 
and the period covered by your report. 
For example, if you create a report for 
the period between 2:00 p.m. and 4:00 
p.m. of a single day, and you specified 
an Interval Time of 15 minutes, your 
report will contain eight rows.

HistoryActions
ReportsACDIntervalTime
Intervaltime

Below 
Threshold 1

The total number of Interactions 
accepted by Agents within the First 
defined threshold for Interactions set for 
the Report.

HistoryActions
ReportsACDIntervalTime
Callthreshold1
callbackthreshold1
WebCallbackthreshold1
Chathreshold1
Emailthreshold1
Faxthreshold1

Below 
Threshold 2

The total number of Interactions 
accepted by Agents within the Second 
defined threshold for Interactions set for 
the Report.

HistoryActions
ReportsACDIntervalTime
Callthreshold2
callbackthreshold2
WebCallbackthreshold2
Chathreshold2
Emailthreshold2
Faxthreshold2
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Creating a Workgroup Interval Time Report 

1. Click Reports > Workgroup Productivity > Workgroup 
Interval Time. 

2. Click Add.

Greater than 
Threshold 2

The total number of Interactions 
accepted by Agents outside of the 
Second Threshold for Interactions set 
for the Report.

HistoryActions
ReportsACDIntervalTime
Callthreshold2
callbackthreshold2
WebCallbackthreshold2
Chathreshold2
Emailthreshold2
Faxthreshold2

Abandon 
Interactions

The total number of interactions where 
the client disconnected after entering 
the queue but before reaching an agent.

HistoryActions
ReportsACDIntervalTime
hasdropped

Service 
Performance 
Level

The percentage of calls answered within 
the time specified (can be up to 60 
seconds and as little as 5 seconds) in 
the Calls must be answered within or 
Chats must be answered within 
controls of the Content tab.

HistoryActions
ReportsACDIntervalTime
haspercentageservicelevel

Total 
Interactions

Total number of Interactions received. HistoryActions
ReportsACDIntervalTime
HasTotalInteractions

Table 3-10Workgroup Interval Time Report Columns (Part 2 of 2)

Column Description Table/Field
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Figure 3-7 Add Report Definition: Name Tab

Figure 3-7. Add Report Definition: Name Tab

3. Complete the Name tab for your Workgroup Interval Time report.

4. Click Content.

Table 3-11

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Workgroup 
Interval Time report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Workgroup Interval Time report definitions.
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Figure 3-8 Workgroup Interval Time Report: Content Tab

Figure 3-8. Workgroup Interval Time Report: Content Tab

5. Complete the Content tab.

Table 3-12

Field Description

Include 
Statistics On

Click the elements to include in the report in the Include 
Statistics On area. Click

• Workgroup Calls to report on Phone Interactions
• Callbacks to report on ACD Callback Interactions
• Web Callback to report on ACD Web Callback Interactions
• Chats to report on Chat Interactions
• Emails to report on Email Interactions
• VoiceMails to report on ACD VoiceMails
• Faxes to report on Fax Interactions

Interval Time Set period of time for interval to report on (15 min., 60 min, and 
so on)
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6. Click Layout.

Figure 3-9 Workgroup Interval Time Report: Layout Tab

Figure 3-9. Workgroup Interval Time Report: Layout Tab

Set 
Threshold 
Times

Enter Values for First and Second Thresholds for Agents to 
respond to each type of Interaction. Using the drop-down 
boxes, select the time in hours, minutes and seconds as 
appropriate.

Using Data 
Source

Click Projects or Workgroups to indicate which data source 
to report on, then select one or all to include in the report.

Table 3-12

Field Description
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7. Complete the Layout tab.

8. Click Regional Options.

Figure 3-10 Add Report Definition: Regional Options Tab

Figure 3-10. Add Report Definition: Regional Options Tab

Table 3-13

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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9. Complete the Regional Options tab.

10. Click Permissions.

Figure 3-11 Add Report Definition: Permissions Tab

Figure 3-11. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

Table 3-14

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. Also, selecting a Start and End time for this report is 
slightly different than for other reports. See “A Note About 
Start and End Times” on page 14-7.

• See page 14-10 for information about deleting a report.

Workgroup Interval Time by Media Report
The Workgroup Interval Time by Media Report shows how your Agents 
are performing at specific times of the day. You can report on time 
intervals as narrow as 1 minute and as long as 60 minutes. Use the 
Set Interval Time control to specify the length of the time intervals 
to report on. The sample below shows a Workgroup Interval Time by 
Media Report created to display intervals of 60 minutes.
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Figure 3-12 Workgroup Interval Time By Media Report

Figure 3-12. Workgroup Interval Time By Media Report

Report Elements
Each row of the Workgroup Interval Time by Media Report is dedicated 
to a single time interval based on the value you supply for Set 
Interval Time on the Content tab. 
The Workgroup Productivity Reports 3-23



Table 3-15Workgroup Interval Time by Media Report Columns (Part 1 of 2)

Column Description Table/Field

Interval The time span to report on in each row 
of the report. You can set the length 
for each interval in the Set Interval 
Time field on the Content tab when 
creating the report definition.

The total number of rows in the report 
is based on your specified Interval 
Time and the period covered by your 
report. For example, if you create a 
report for the period between 2:00 
p.m. and 4:00 p.m. of a single day, 
and you specified an Interval Time of 
15 minutes, your report will contain 
eight rows.

HistoryActions
ReportsACDInterval
timeinterval

Workgroup Calls The total number of Workgroup Phone 
calls accepted by Agents.

HistoryActions
ReportsACDInterval
hasacdcalls

Callback The total number of Callback 
Interactions accepted by Agents.

HistoryActions
ReportsACDInterval
hasacdcallback

Workgroup Email The total number of Workgroup email 
Interactions accepted by Agents

HistoryActions
ReportsACDInterval
hasacdemail

Workgroup Fax The total number of Workgroup fax 
Interactions accepted by Agents

HistoryActions
ReportsACDInterval
hasacdfax

Web Callback The total number of Web Callback 
Interactions accepted by Agents

HistoryActions
ReportsACDInterval
hasacdwebcallback

Chat The total number of Chat Interactions 
accepted by Agents

HistoryActions
ReportsACDInterval
HasAcdChat
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Creating a Workgroup Interval Time by Media Report

1. Click Reports > Workgroup Productivity > Workgroup Interval Time 
by Media.

2. Click Add.

Figure 3-13 Add Report Definition: Name Tab

Figure 3-13. Add Report Definition: Name Tab

Workgroup 
Voicemail

The total number of Workgroup 
Voicemail Interactions accepted by 
Agents

HistoryActions
ReportsACDInterval
HasAcdVoicemail

Total Total number of Interactions received. HistoryActions
ReportsACDInterval
hastotinteractions

Table 3-15Workgroup Interval Time by Media Report Columns (Part 2 of 2)

Column Description Table/Field
The Workgroup Productivity Reports 3-25



3. Complete the Name tab for your Workgroup Interval Time by 
Media report.

4. Click Content.

Figure 3-14 Workgroup Interval Time by Media Report: Content Tab

Figure 3-14. Workgroup Interval Time by Media Report: Content Tab

Table 3-16

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Workgroup 
Interval Time by Media report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Workgroup Interval Time by Media report 
definitions.
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5. Complete the Content tab.

6. Click Layout.

Figure 3-15 Workgroup Interval Time by Media Report: Layout Tab

Figure 3-15. Workgroup Interval Time by Media Report: Layout Tab

Table 3-17

Field Description

Set Interval 
Time

Enter the number of minutes to report on in each row of the 
report (such as an interval of 60 minutes produces 24 rows per 
calendar day reported on).

Using Data 
Source

Click the data source to report on. Click:

• Projects to choose from all Projects defined for your 
Company.

• Workgroups to choose from all Workgroups defined for 
your Company

• Users to choose from all Agents, Supervisors, and 
Administrator accounts defined for your Company.
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7. Complete the Layout tab.

8. Click Regional Options.

Figure 3-16 Add Report Definition: Regional Options Tab

Figure 3-16. Add Report Definition: Regional Options Tab

Table 3-18

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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9. Complete the Regional Options tab.

10. Click Permissions.

Figure 3-17 Add Report Definition: Permissions Tab

Figure 3-17. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

Table 3-19

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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12. Click OK.

CCA saves your report in the database for access by any 
Administrator or Supervisor who is logged into your Company and 
to whom you have given permission to access the report. See 
Chapter 16, “Viewing and Printing Reports,” to generate and print 
the report.

• See page 14-3 for information about viewing and printing a 
report. Also, selecting a Start and End time for this report is 
slightly different than for other reports. See “A Note About 
Start and End Times” on page 14-7.

• See page 14-10 for information about deleting a report.

Outcome Statistics Report
The Outcome Statistics Report allows you to track the results of 
Interactions based on Interaction Type (Workgroup Call, Web Callback, 
and so on). For each Interaction Type, the Outcome Statistics Report 
shows the number of Interactions that were assigned that Outcome by 
Agents at the conclusion of the Interaction. 

Figure 3-18 Outcome Statistics Report

Figure 3-18. Outcome Statistics Report
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Each Outcome defined for your call center is listed in each report 
group, and the number of Interactions receiving that Outcome is 
shown in each column (one Interaction Type per column).

Report Elements
Each data group of the Outcome Statistics Report is dedicated to a 
single Interaction Outcome, while the columns of the report detail the 
number of Interactions to receive that Outcome.

Table 3-18 describes the contents of each column of the Outcome 
Statistics Report.

Table 3-20Outcome Report Interaction Types (Part 1 of 2)

Interaction Type Description Table/Field

Workgroup Emails Email Interactions HistoryActions
ReportsOutcomes
HasEmails

Workgroup Fax Fax Interactions HistoryActions
ReportsOutcomes
Hasfaxes

Chat Chat Interactions HistoryActions
ReportsOutcomes
HasChats

Workgroup Calls Inbound telephone 
Interactions routed to a 
Workgroup Agent, 
including ACD Callback 
requests, but not 
including calls routed to 
voicemail.

HistoryActions
ReportsOutcomes
HasACDCalls

Web Callback Web Callback 
Interactions

HistoryActions
ReportsOutcomes
HasWebCallback

Outbound Outbound calls dialed 
through the CCA system 
(does not include 
outbound call made by 
Agent on telephone 
lines not controlled by 
CCA.

HistoryActions
ReportsOutcomes
HasOutbound
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Creating an Outcome Statistics Report

1. Click Reports > Workgroup Productivity > Outcome Statistics.

2. Click Add.

Inbound Inbound calls routed 
directly to an Agent 
extension (does not 
include calls routed 
through the ACD Server 
to an available 
Workgroup Agent).

HistoryActions
ReportsOutcomes
HasInbound

Preview Preview Interactions HistoryActions
ReportsOutcomes
HasPreview

Predictive Predictive Interactions HistoryActions
ReportsOutcomes
HasPredictive

Callback ACD (Workgroup) 
Callback Interactions.

HistoryActions
ReportsOutcomes
HasCallback

Workgroup Voicemail Voicemails that were left 
for the Workgroup.

HistoryActions
ReportsOutcomes
HasVoicemails

Table 3-20Outcome Report Interaction Types (Part 2 of 2)

Interaction Type Description Table/Field
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Figure 3-19 Add Report Definition: Name Tab

Figure 3-19. Add Report Definition: Name Tab

3. Complete the Name tab for your Outcome Statistics Report.

4. Click Content.

Table 3-21

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Outcome 
Statistics Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Outcome Statistics Report definitions.
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Figure 3-20 Outcome Statistics Report: Content Tab

Figure 3-20. Outcome Statistics Report: Content Tab

5. Complete the Content tab.

6. Click Layout.

Table 3-22

Field Description

Include 
Statistics On

Check the Outcomes to include in the report in the Include 
Statistics On area. Click All to include all elements, or click 
Clear to clear all the check boxes.

Using Data 
Source

Click the data group to report on. Click

• Projects to choose from all Projects defined for your 
Company

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.
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Figure 3-21 Outcome Statistics Report: Layout Tab

Figure 3-21. Outcome Statistics Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 3-23

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.

Include Chart in the 
Report

Check Include Chart in the Report to include a 
graphical representation of the report information in 
the generated report. Verify the report layout in the 
Preview area.
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Figure 3-22 Add Report Definition: Regional Options Tab

Figure 3-22. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 3-24

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 3-23 Add Report Definition: Permissions Tab

Figure 3-23. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Overdue Callbacks Report
The Overdue Callbacks Report lists all waiting Web callback 
Interactions. Based on your overdue criteria and the date and time for 
which the customer scheduled the callback, this report indicates 
whether Interactions are overdue, recently overdue, or upcoming.
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Figure 3-24 Overdue Callbacks Report

Figure 3-24. Overdue Callbacks Report

Report Elements

Each unhandled Web callback Interaction listed in the Overdue 
Callbacks Report shows the date and time the customer requested the 
callback, as well as the contact information provided by the customer.

The report places each Interaction into one of the following groups:

Table 3-25Overdue Callbacks Report Groups

Group Description

Overdue Your specified Overdue Threshold time has elapsed 
since the time for which the customer requested the 
callback.
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Creating an Overdue Callbacks Report

1. Click Reports > Workgroup Productivity > Overdue Callbacks

2. Click Add.

Figure 3-25 Add Report Definition: Name Tab

Figure 3-25. Add Report Definition: Name Tab

Recently Overdue The time for which the customer requested the callback 
has passed, but your specified Overdue Threshold time 
has not yet elapsed.

Upcoming The time for which the customer requested the callback 
has not yet arrived.

Table 3-25Overdue Callbacks Report Groups

Group Description
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3. Complete the Name tab for your Overdue Callbacks Report.

4. Click Content.

Figure 3-26 Overdue Callbacks Report: Content Tab

Figure 3-26. Overdue Callbacks Report: Content Tab

Table 3-26

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Overdue 
Callbacks Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Overdue Callbacks Report definitions.
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5. Complete the Content tab.

6. Click Layout.

Figure 3-27 Overdue Callbacks Report: Layout Tab

Figure 3-27. Overdue Callbacks Report: Layout Tab

Table 3-27

Field Description

Overdue Threshold Enter the number of minutes after which unhandled Web 
callback Interactions should be reported as Overdue.

For example, if you enter a value of 30 minutes, and the 
customer requested the callback for noon, CCA reports 
the Interaction as “Recently Overdue” at 12:29 p.m., and 
as “Overdue” at 12:31 p.m.

Specify the Report 
Time Period

Check to allow the Supervisor or Administrator 
generating the report to specify a date range to report 
on. Clear this box to report on all unhandled Web 
callback Interactions.

Using Data Source Select one or all of your Projects.
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7. Complete the Layout tab.

8. Click Regional Options.

Figure 3-28 Add Report Definition: Regional Options Tab

Figure 3-28. Add Report Definition: Regional Options Tab

Table 3-28

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.

Include Chart in the 
Report

Check Include Chart in the Report to include a 
graphical representation of the report information in 
the generated report. Verify the report layout in the 
Preview area.
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9. Complete the Regional Options tab.

10. Click Permissions.

Figure 3-29 Add Report Definition: Permissions Tab

Figure 3-29. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

Table 3-29

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.
3-44 CallCenterAnywhereTM Administration Manager



4

The Predictive Preview Reports 4

Predictive Dialer Totals Report
The Predictive Dialer Totals Report shows a group of call related 
statistics (number of calls, answer rate, and so on) for predictive 
dialing.

Figure 4-1 Sample Predictive Dialer Totals Report 

Figure 4-1. Sample Predictive Dialer Totals Report
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Report Elements
Table 4-1Predictive Dialer Totals Report Fields

Item Description Table/Field

Project 
Name

The name of the Project(s) you selected for the report. PredictiveProjectStats
ReportsPredictiveTotal

Time Each row in the report shows the statistics for one 
minute of predictive dialing. For example, if you chose 
a report start time of 9:00 am, and a report end time of 
5:00 pm (View dialog > Period Covered tab), your 
report will have 480 rows for each project that you 
selected (Edit > Projects tab). 

PredictiveProjectStats
ReportsPredictiveTotal

Number 
of Calls

The number of predictive dialing calls that have been 
made since the dialing started. This number is 
cumulative for as long as the Predictive Project is 
running. If you stop the Project, the number of calls 
will be reset to 0.

PredictiveProjectStats
ReportsPredictiveTotal

Number 
of Active 
Calls

A call is considered active when the system begins 
dialing that number. A call is considered inactive when 
a customer or agent hangs up, or when the system 
hangs up. This field is the number of calls that were 
active in the system during the reporting interval. 

For example, if the project is in the 5th minute of 
running, the total number of calls that have been 
made (Number of Calls) might be 50. However, during 
the 5th minute, only 15 calls might be active.

PredictiveProjectStats
ReportsPredictiveTotal

Dropped 
Rate

A dropped call occurs when the system hangs up on 
the customer before the customer is connected to an 
Agent (system shutdown, no available Agents, and so 
on)

The Dropped Rate is defined as: 

This field is cumulative.

PredictiveProjectStats
ReportsPredictiveTotal

The total number of calls that were dropped
total number of calls that were answered by a customer
---------------------------------------------------------------------------------------------------------------------------------------------------
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Answer 
Rate 

The Answer Rate is defined as: 

This field is cumulative. 

PredictiveProjectStats
ReportsPredictiveTotal

Average 
Waiting 
Time

Wait time is the amount time that an Agent was 
available but was not given a call. The Average Wait 
Time is the average amount of time that all Agents in 
the project spent waiting to be given a call since 
predictive dialing began. This field is cumulative.

To be considered “waiting” an Agent must be 
1. Available
2. Associated with a Predictive Project that is 

running. 
3. Logged into Predictive Dialing.

PredictiveProjectStats
ReportsPredictiveTotal

Number 
of Calls 
Per Hour

The average number of calls made per hour. It is 
defined as: 

PredictiveProjectStats
ReportsPredictiveTotal

Number 
of Calls 
Per 
Agent

The Number of Calls Per Agent is defined as: 

This field is cumulative.

PredictiveProjectStats
ReportsPredictiveTotal

Dialer 
Ratio

Dialer ratio is the number of calls that are made 
simultaneously for an Agent.

The Dialer ratio can either be fixed or pacing. See the 
Dialer Ratio tab on page 9-19.

PredictiveProjectStats
ReportsPredictiveTotal

Table 4-1Predictive Dialer Totals Report Fields

Item Description Table/Field

 total number of calls that were answered by a customer
The total number of calls that were made

----------------------------------------------------------------------------------------------------------------------------------------------------

The total number of calls made
The total dialing time

---------------------------------------------------------------------------------- 60¥

The total number of calls
The total  number of times that Agents were available
---------------------------------------------------------------------------------------------------------------------------------------------
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Creating a Predictive Dialer Totals Report

1. Click Reports > Predictive/Preview Reports > Predictive Dialer 
Totals.

2. Click Add.

Figure 4-2 Add Report Definition: Name Tab

Figure 4-2. Add Report Definition: Name Tab

3. Enter a Report Name and Description for your report.

4. Click Content.

Table 4-2

Field Description

Report 
Name

The report name will appear on each page of the report and in 
the Name column of the list of Predictive Dialer Totals Report 
definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Predictive Dialer Totals Report definitions.
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Figure 4-3 Predictive Dialer Totals Report: Content Tab

Figure 4-3. Predictive Dialer Totals Report: Content Tab

5. Complete the Content tab.

Select one or all of your Projects.

6. Select Layout.
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Figure 4-4 Predictive Dialer Totals Report: Layout Tab

Figure 4-4. Predictive Dialer Totals Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 4-3

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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Figure 4-5 Add Report Definition: Regional Options Tab

Figure 4-5. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 4-4

Choose... To display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
Company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language you choose.

Company Default 
Date Format

All dates will be formatted using the format set for the 
Company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 4-6 Add Report Definition: Permissions Tab

Figure 4-6. Add Report Definition: Permissions Tab

11. Click on the Any Supervisor radio button to give all Supervisors 
access to your report. Click on The Following Supervisors to 
select supervisors from a list.

12. Click OK or Apply. 

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Predictive Productivity Report
The Predictive Productivity Report provides a snapshot of results 
for a specific Predictive Dialing Project.
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Figure 4-7 Predictive Productivity Report

Figure 4-7. Predictive Productivity Report

Report Elements
.

Table 4-5Predictive Productivity Report Columns

Column Description Table/Field

Agent Name Name of Agent included in 
Report.

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasAgentName

Log in Duration Length of Time Agent Logged 
into Predictive Campaign

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasLoginDuration
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Creating a Predictive Productivity Report

1. Click Reports > Predictive/Preview Reports > Predictive 
Productivity.

2. Click Add.

Talk Time Length of Time Agent spent in 
Busy Status during Predictive 
Campaign

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasTalkTime

Talk Time per Log 
In

Percentage of Time Agent 
spent in Busy Status during 
Predictive Campaign

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasTalkTimeperLoginTime

Calls Taken Number of Calls taken during 
Login

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasCallsTaken

Calls per Hour Number of Calls taken per 
Hour (Number of Calls/Login 
Time)

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasCallsPerHour

Number of Sales Number of Sales HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasNumberofSales

Close Rate Sales Percentage of Sales against 
Number of Calls taken during 
Login

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasSalesCloseRate

Sales per Hour Number of Sales Per Hour 
(Number of Sales/Login Time)

HistoryActions
HistoryOutcome
ProjectsPredictiveProduction
HasSalesperHour

Table 4-5Predictive Productivity Report Columns

Column Description Table/Field
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Figure 4-8 Add Report Definition: Name Tab

Figure 4-8. Add Report Definition: Name Tab

3. Complete the Name tab for your Predictive Productivity Report.

4. Click Content.

Table 4-6

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Predictive 
Productivity Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Predictive Productivity Report definitions.
The Predictive Preview Reports 4-11



Figure 4-9 Predictive Productivity Report: Content Tab

Figure 4-9. Predictive Productivity Report: Content Tab

5. Complete the Content tab.

6. Click Layout.

Table 4-7

Field Description

Include 
Statistics On

Check the Outcomes to include in the report in the Include 
Statistics On area. Click All to include all elements, or click 
Clear to clear all the check boxes.

Using Data 
Source

Click the data group to report on. Click

• Projects to choose from all Projects defined for your 
Company

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.
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Figure 4-10 Predictive Productivity Report: Layout Tab

Figure 4-10. Predictive Productivity Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 4-8

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.

The Format of your report will be displayed on the 
right hand side of the page.
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Figure 4-11 Add Report Definition: Regional Options Tab

Figure 4-11. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 4-9

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 4-12 Add Report Definition: Permissions Tab

Figure 4-12. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Predictive Summary Report
The Predictive Summary Report lists the total occurrences of each 
possible Predictive Call result for the selected Projects or Workgroups.
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Figure 4-13 Example Predictive Summary Report

Figure 4-13. Example Predictive Summary Report

Report Elements
The sample report above shows the results of some predictive dialing, 
but this report can also show statistics for Actions and Outcomes.
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Table 4-10Predictive Summary Report Columns

Column Description Table/Field

Result The result of the Predictive call attempt. Can be 
one of the following:

Answer: A person answered the Predictive call
Answer, Not Connected: The Predictive call 
was answered but the agent and the client were 
not connected.
Answering Machine: An answering machine 
answered the Predictive Call
Answering Machine, Not Connected: The 
Predictive call was answered but the agent and 
the answering machine were not connected.
Busy: Predictive call resulted in a busy signal
Error: An error (no dial tone, no line available, 
and so on) prevented the Predictive call from 
being placed.
Fax: A fax machine answered the Predictive call
Invalid: The number used for the Predictive call 
was out of service or not a valid number
No Answer: There was no answer at the 
number dialed.

LibOutcome
ReportsOutcome
ReportsPredictive
HistoryPredictiveResults
ResultsID
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Action The Action taken as a result of the Predictive 
call attempt. Can be one of:
Abandon before connect: Call was abandon 
before connecting.
Call back: Will call this number back at the 
specified time.
Call back message: Left the specified message 
on the answering machine that answered the 
Predictive call and will call this number back at 
the specified time.
Call back message failed: Failed to leave the 
specified message on the answering machine 
that answered the Predictive call.
Call failed: The Predictive call failed.
Connect to agent: Predictive call was 
connected with an Agent.
Leave message: Left the specified message on 
the answering machine that answered the 
Predictive call.
Leave message failed: Failed to leave the 
specified message on the answering machine 
that answered the Predictive call.
Out of list: The number was removed from the 
Predictive database and will not be called again
Route to project: The Predictive call was 
answered then routed to a project.
Route to project failed: The Predictive call was 
answered but routing to the specified project 
failed.
Send fax: Sent the specified fax to the fax 
machine that answered the Predictive call.
Send fax failed: An attempt to send a fax was 
unsuccessful

LibOutcome
ReportsOutcome
ReportsPredictive
HistoryPredictiveResults
ActionID

Outcomes Outcomes are call results that are configured by 
the Company Administrator and assigned to the 
Predictive Project.

HistoryPredictiveResults
LibOutcome
ReportsOutcome
ReportsPredictive

Total Total number of Predictive call attempts 
receiving the Result.

HistoryPredictiveResults
LibOutcome
ReportsOutcome
ReportsPredictive

Table 4-10Predictive Summary Report Columns

Column Description Table/Field
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Creating a Predictive Summary Report

1. Click Reports > Predictive/Preview Reports > Predictive Summary.

2. Click Add.

Figure 4-14 Add Report Definition: Name Tab

Figure 4-14. Add Report Definition: Name Tab

3. Complete the Name tab for your Predictive Summary Report.

4. Click Content.

Table 4-11

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Predictive 
Summary Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Predictive Summary Report definitions.
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Figure 4-15 Predictive Summary Report: Content Tab

Figure 4-15. Predictive Summary Report: Content Tab
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5. Complete the Content tab.

6. Click Layout.

Table 4-12

Field Description

Include 
Statistics On

Check the Predictive Summary to include in your report. See 
Results for a description of each of the possible Predict Result 
Types. See Actions for a description of each of the possible 
Action Types. See Outcomes for a description of the possible 
Outcomes types.

Click All or Clear to check or clear, respectively, the specific 
Predictive Summary to include in the report.

Using Data 
Source

Click the data group to report on. Click

• Projects to choose from all Projects defined for your 
Company

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.
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Figure 4-16 Predictive Summary Report: Layout Tab

Figure 4-16. Predictive Summary Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 4-13

Field Description

Build Report Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.

To include a Chart in your Report, select “Include 
Chart” box and then select the type of Chart to be 
included. 

The Format of your report will be displayed on the 
right hand side of the page.

Include Chart in the 
Report

Click this check box to include a chart in your 
report; then choose the chart type: vertical bar, 
horizontal bar, or pie chart. 
The Predictive Preview Reports 4-23



Figure 4-17 Add Report Definition: Regional Options Tab

Figure 4-17. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 4-14

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 4-18 Add Report Definition: Permissions Tab

Figure 4-18. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report.

• See page 14-10 for information about deleting a report.

Predictive Detailed Report
The Predictive Detailed Report can be run in a number of ways and the 
report itself can be quite large. In general, the report shows:

• Results of the call (Answered, Error, Answer Machine, and so on)

• Outcome of the call (Sale, Sale Pending, No Sale, and so on) 
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• Actions taken after the call (call back later, leave a message, and 
so on)

The sample report below shows all Results for each Action.

Figure 4-19 Predictive Detailed Report

Figure 4-19. Predictive Detailed Report
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Report Elements

Table 4-5 describes the elements of the Predictive Detailed Report.

Table 4-15

Column Description Table/Field

Project Name The CCA Predictive Calling Project 
name.

ReportsPredictive
HistoryActions
HistoryPredictiveResults
HistoryOutcomes

Outcome The Outcome assigned to the 
Interaction by the Agent. See 
“Creating Interaction Outcomes” on 
page 4-11.

ReportsPredictive
HistoryActions
HistoryPredictiveResults
HistoryOutcomes

Workgroup 
Name

The Workgroup that handled the 
Predictive call.

ReportsPredictive
HistoryActions
HistoryPredictiveResults
HistoryOutcomes

Phone The telephone number dialed in the 
Predictive call attempt.

ReportsPredictive
HistoryActions
HistoryPredictiveResults
HistoryOutcomes
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Result Type The result of the Predictive call 
attempt. Can be one of the 
following:

Answer: A person answered the 
Predictive call
Answer, Not Connected: The 
Predictive call was answered but 
the agent and the client were not 
connected.
Answering Machine: An answering 
machine answered the Predictive 
Call
Answering Machine, Not 
Connected: The Predictive call was 
answered but the agent and the 
answering machine were not 
connected.
Busy: Predictive call resulted in a 
busy signal
Error: An error (no dial tone, no line 
available, and so on) prevented the 
Predictive call from being placed.
Fax: A fax machine answered the 
Predictive call
Invalid: The number used for the 
Predictive call was out of service or 
not a valid number
No Answer: There was no answer 
at the number dialed.

ReportsPredictive
HistoryActions
HistoryPredictiveResults
HistoryOutcomes
ResultID

Table 4-15

Column Description Table/Field
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Action The Action taken as a result of the 
Predictive call attempt. Can be one 
of:
Abandon before connect: Call 
was abandon before connecting.
Call back: Will call this number 
back at the specified time.
Call back message: Left the 
specified message on the 
answering machine that answered 
the Predictive call and will call this 
number back at the specified time.
Call back message failed: Failed 
to leave the specified message on 
the answering machine that 
answered the Predictive call.
Call failed: The Predictive call 
failed.
Connect to agent: Predictive call 
was connected with an Agent.
Leave message: Left the specified 
message on the answering machine 
that answered the Predictive call.
Leave message failed: Failed to 
leave the specified message on the 
answering machine that answered 
the Predictive call.
Out of list: The number was 
removed from the Predictive 
database and will not be called 
again
Route to project: The Predictive 
call was answered then routed to a 
project.
Route to project failed: The 
Predictive call was answered but 
routing to the specified project 
failed.
Send fax: Sent the specified fax to 
the fax machine that answered the 
Predictive call.
Send fax failed: An attempt to send 
a fax was unsuccessful

ReportsPredictive
HistoryActions
HistoryPredictiveResults
HistoryOutcomes
ActionID

Table 4-15

Column Description Table/Field
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Creating a Predictive Detailed Report

1. Click Reports > Predictive/Preview Reports > Predictive Detailed.

2. Click Add.

Figure 4-20 Add Report Definition: Name Tab

Figure 4-20. Add Report Definition: Name Tab

3. Complete the Name tab for your Predictive Detailed Report.

4. Click Content.

Table 4-16

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Predictive 
Detailed Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Predictive Detailed Report definitions.
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Figure 4-21 Predictive Detailed Report: Content Tab

Figure 4-21. Predictive Detailed Report: Content Tab

5. Complete the Content tab
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Table 4-17

Field Description

Include 
Statistics On

The Predictive Detailed Report is a nested report. The top 
three radio buttons let you select the “outer nest”. The bottom 
two radio buttons are the “inner nest”. 

Example 1: 
• Choose Results from the top three radio buttons
• Choose Actions from the bottom two radio buttons. 
Your report will look like this: 

Error (Result 1)
Callback (Action 1)
Callback Message (Action 2)
Connect to Agent (Action 3)
. . . 

Busy (Result 2)
Callback (Action 1)
Callback Message (Action 2)
Connect to Agent (Action 3)
. . . 

Example 2 - try the reverse: 
• Choose Actions from the top three radio buttons
• Choose Results from the bottom two radio buttons. 
Your report will look like this: 

Callback (Action 1)
Error (Result 1)
Busy (Result 2)
No Answer (Result 3)
. . . 

Callback Message (Action 2)
Error (Result 1)
Busy (Result 2)
No Answer (Result 3)
. . . 
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6. Click Layout.

Figure 4-22 Predictive Detailed Report: Layout Tab

Figure 4-22. Predictive Detailed Report: Layout Tab

Using Data 
Source

Click the data group to report on. Click

• Projects to choose from all Projects defined for your 
Company

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.

Table 4-17

Field Description
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7. Complete the Layout tab.

8. Click Regional Options.

Figure 4-23 Add Report Definition: Regional Options Tab

Figure 4-23. Add Report Definition: Regional Options Tab

Table 4-18

Field Description

Build Report Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.

Include a Chart You can include a Chart in the Report by clicking 
the “Include a Chart” button, the selecting the type 
of Chart to be included in the Report.

When you are finished, the layout of the report will 
be displayed on the right of the Page.
The Predictive Preview Reports 4-35



9. Complete the Regional Options tab.

10. Click Permissions.

Figure 4-24 Add Report Definition: Permissions Tab

Figure 4-24. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

Table 4-19

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Preview Summary Report
The Preview Summary Report displays a breakdown of the results 
(busy, no answer, and so on) of all Preview call attempts, and the 
follow-up action taken in response to each result.

Figure 4-25 The Preview Summary Report

Figure 4-25. he Preview Summary Report
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Report Elements
Table 4-20Preview Summary Report Columns

Column Description Table/Field

Project The CCA Preview Calling Project 
name.

HistoryActions
HistoryPredictiveResults
ReportsPreview

Outcome The Outcome assigned to the 
Interaction by the Agent.

HistoryActions
HistoryPredictiveResults
ReportsPreview
HasOutcomeName
4-38 CallCenterAnywhereTM Administration Manager



Phone The telephone number dialed in 
the Preview call attempt.

HistoryActions
HistoryPredictiveResults
ReportsPreview
HasPhone

Action The Action taken as a result of 
the Predictive call attempt. Can 
be one of:

Call Back Will call this number 
back at the specified time.
Call not connected An 
answering machine answered the 
Predictive Call
Connected Predictive call was 
connected with an Agent.
Failed to send fax An attempt to 
send a fax was unsuccessful
Fax file not found The .TIF file to 
be faxed could not be found at the 
specified location.
Fax sent Sent the specified fax to 
the fax machine that answered 
the Predictive call.
Left message and will call back 
Left the specified message on the 
answering machine that 
answered the Predictive call and 
will call this number back at the 
specified time
License not available There was 
not a license available to permit 
connection of the Predictive 
Interaction to an Agent.
Message on the answering 
machine Left the specified 
message on the answering 
machine that answered the 
Predictive call.
Remove from list The number 
was removed from the Predictive 
database and will not be called 
again.

HistoryActions
HistoryPredictiveResults
ReportsPreview
HasAction
ActionID

Table 4-20Preview Summary Report Columns

Column Description Table/Field
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Creating a Preview Summary Report

1. Click Reports > Predictive/Preview Reports > Preview Summary.

2. Click Add.

Figure 4-26 Add Report Definition: Name Tab

Figure 4-26. Add Report Definition: Name Tab

3. Complete the Name tab for your Preview Summary Report.

4. Click Content.

Table 4-21

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Preview 
Summary Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Preview Summary Report definitions.
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Figure 4-27 Preview Summary Report: Content Tab

Figure 4-27. Preview Summary Report: Content Tab

5. Complete the Content tab.

6. Click Layout.

Table 4-22

Field Description

Include 
Statistics On

Check the Predictive Results to include in your report. Click All 
or Clear to check or clear, respectively, the specific Predictive 
Results to include in the report.

Using Data 
Source

Click the data group to report on. Click

• Projects to choose from all Projects defined for your 
Company

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this department to report on selected 
Departments.
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Figure 4-28 Preview Summary Report: Layout Tab

Figure 4-28. Preview Summary Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 4-23

Field Description

Build Report Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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Figure 4-29 Add Report Definition: Regional Options Tab

Figure 4-29. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 4-24

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 4-30 Add Report Definition: Permissions Tab

Figure 4-30. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.
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5

The Agent Profile and Productivity 
Reports 5

Agent Information Report
The Agent Information Report can show the following profile 
information for each Agent in the selected Workgroups:

• First and last name
• Telephone number
• Phone Extension
• Email address
• Active Address
• Skills assigned to the Agent
• Workgroups the Agent is a member of

Note that, although you can select and remove columns from the 
report, this report will always sort by the Agent’s last name.
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Figure 5-1 Agent Information Report

Figure 5-1. Agent Information Report

Creating an Agent Information Report

1. Click Reports > Agent Profile & Productivity > Agent Information.

2. Click Add.

Figure 5-2 Add Report Definition: Name Tab

Figure 5-2. Add Report Definition: Name Tab
5-2 CallCenterAnywhereTM Administration Manager



3. Complete the Name tab for your Agent Information report.

4. Click Content.

Figure 5-3 Agent Information Report: Content Tab

Figure 5-3. Agent Information Report: Content Tab

Table 5-1

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Agent 
Information report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Agent Information report definitions.
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5. Complete the Content tab.

6. Click Layout.

Figure 5-4 Agent Information Report: Layout Tab

Figure 5-4. Agent Information Report: Layout Tab

Table 5-2

Field Description

Include 
Statistics On

Click the data group to report on. Click

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.
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7. Complete the Layout tab.

8. Click Regional Options.

Figure 5-5 Add Report Definition: Regional Options Tab

Figure 5-5. Add Report Definition: Regional Options Tab

Table 5-3

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.

Note that, although you can select and remove 
columns from the report, this report will always sort 
by the Agent’s last name.
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9. Complete the Regional Options tab.

10. Click Permissions.

Figure 5-6 Add Report Definition: Permissions Tab

Figure 5-6. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

Table 5-4

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Agent Interaction Report
The Agent Interaction Report lets you analyze Agent usage by 
showing the amount of time each Agent spent handling Interactions, 
awaiting Interactions, or on break.

Note that if you run this report “by workgroup” (see, “Using Data 
Source” on page 5-11) the report will not NOT contain direct inbound 
or direct outbound calls that the Agent made or received, since direct 
calls are not routed through workgroups.

Figure 5-7 Agent Interaction Report

Figure 5-7. Agent Interaction Report
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Report Elements
Each row of the Agent Interaction Report is dedicated to a single 
Agent. The report columns show details on the Interaction types that 
were handled by the Agent and whether or not the specific Interaction 
type should be included in the Report.

Table 5-5Agent Interaction Report

Column Description Table/Field

Workgroup 
Calls

The number of Workgroup Calls 
the Agent accepted.

HistoryActions
ReportsAgentInteractions
HasACDCalls

Voicemail The number of Voicemail 
Interactions the Agent accepted.

HistoryActions
ReportsAgentInteractions
HasVoicemail

CallBack The number of Callback 
Interactions the Agent accepted.

HistoryActions
ReportsAgentInteractions
HasACDCallback

Web CallBack The number of Web Callback 
Interactions the Agent accepted.

HistoryActions
ReportsAgentInteractions
HasWebCallback

Outbound The number of outbound calls 
placed to customers by the Agent.

HistoryActions
ReportsAgentInteractions
HasOutbound

Inbound The number of inbound calls 
originated by a customer accepted 
by the Agent.

HistoryActions
ReportsAgentInteractions
HasInbound

In Ext The number of telephone calls the 
Agent received from to another 
CCA Agent.

HistoryActions
ReportsAgentInteractions
HasInExt

Out Ext The number of telephone calls this 
Agent placed to other CCA Agents.

HistoryActions
ReportsAgentInteractions

Email The number of email Interactions 
accepted by the Agent.

HistoryActions
ReportsAgentInteractions
HasOutExt

Fax The number of fax Interactions 
accepted by the Agent.

HistoryActions
ReportsAgentInteractions
HasFax
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Creating an Agent Interaction Report

1. Click Reports > Agent Profile & Productivity > Agent Interaction.

2. Click Add.

Figure 5-8 Add Report Definition: Name Tab

Figure 5-8. Add Report Definition: Name Tab

Chat The number of chat Interactions 
accepted by the Agent.

HistoryActions
ReportsAgentInteractions
HasChat

Preview The number of Preview call 
Interactions placed by the Agent.

HistoryActions
ReportsAgentInteractions
HasPreview

Predictive The number of Predictive call 
Interactions accepted by the Agent.

HistoryActions
ReportsAgentInteractions
HasPredictive

Total The total number of Interactions 
handled by the Agent.

HistoryActions
ReportsAgentInteractions

Table 5-5Agent Interaction Report

Column Description Table/Field
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3. Complete the Name tab for your Agent Interaction report.

4. Click Content.

Figure 5-9 Agent Interaction Report: Content Tab

Figure 5-9. Agent Interaction Report: Content Tab

Table 5-6

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Agent 
Interaction report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Agent Interaction report definitions.
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5. Complete the Content tab.

6. Click Layout.

Figure 5-10 Agent Interaction Report: Layout Tab

Figure 5-10. Agent Interaction Report: Layout Tab

Table 5-7

Field Description

Using Data 
Source

Click the data group to report on. Click

• Projects to choose from all Projects defined for your 
Company

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup. Note that if you choose “Users from 
this Workgroup”, the report will not NOT contain direct 
inbound or direct outbound calls that the Agent made or 
received, since direct calls are not routed through 
workgroups. 

• Users from this department to report on selected 
Departments.
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7. Complete the Layout tab.

8. Click Regional Options.

Figure 5-11 Add Report Definition: Regional Options Tab

Figure 5-11. Add Report Definition: Regional Options Tab

Table 5-8

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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9. Complete the Regional Options tab.

10. Click Permissions.

Figure 5-12 Add Report Definition: Permissions Tab

Figure 5-12. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

Table 5-9

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Agent Skills Report
The Agent Skills Report lists: 

• All the Skills that have been defined for your Company

• Which Agents possess that skill and 

• Each Agent’s rating for that skill. 

The Agent Skills Report quickly shows you which Agents possess each 
skill in your call center. You can use the Agent Skills Report to decide 
which Agents to include in a Workgroup that requires specific skills or 
requirements.

Figure 5-13 Agent Skills Report

Figure 5-13. Agent Skills Report
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Creating an Agent Skills Report

1. Click Reports > Agent Profile & Productivity > Agent Skills.

2. Click Add.

Figure 5-14 Add Report Definition: Name Tab

Figure 5-14. Add Report Definition: Name Tab

3. Complete the Name tab for your Agent Skills Report.

4. Click Content.

Table 5-10

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Agent Skills 
Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Agent Skills Report definitions.
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Figure 5-15 Agent Skills Report: Content Tab

Figure 5-15. Agent Skills Report: Content Tab

5. Complete the Content tab.

6. Click Layout.

Table 5-11

Field Description

Include 
Statistics On

Check the Skills to include in the report in the Include 
Statistics On area. Click All to include all elements, or click 
Clear to clear all the check boxes.

Use Data 
Source

Click the data group to report on. Click

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.
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Figure 5-16 Agent Skills Report: Layout Tab

Figure 5-16. Agent Skills Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 5-12

Field Description

Build Report Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
The Agent Profile and Productivity Reports 5-17



Figure 5-17 Add Report Definition: Regional Options Tab

Figure 5-17. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 5-13

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 5-18 Add Report Definition: Permissions Tab

Figure 5-18. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Agent Utilization Report
The Agent Utilization Report helps you analyze Agent activity by 
showing the amount of time each Agent spent handling Interactions, 
awaiting Interactions, or on break.
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Figure 5-19 Agent Utilization Report

Figure 5-19. Agent Utilization Report

Creating an Agent Utilization Report

1. Click Reports > Agent Profile & Productivity > Agent Utilization.

2. Click Add.

Figure 5-20 Add Report Definition: Name Tab

Figure 5-20. Add Report Definition: Name Tab
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3. Complete the Name tab for your Agent Utilization report.

4. Click Content.

Figure 5-21 Agent Utilization Report: Content Tab

Figure 5-21. Agent Utilization Report: Content Tab

Table 5-14

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Agent Utilization 
report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Agent Utilization report definitions.
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5. Complete the Content tab.

6. Click Layout.

Table 5-15

Field Description Table/Field

Include 
Statistics On

Check Timing to display the elapsed 
time each Agent spent in each status. 
Check Percentage to display the time, 
expressed as a relative percentage, 
that each Agent spent in each status.

History Actions
ReportsAgentUtilization
HasBusy
HasAvailable
HasOnBreak
HasTiming
HasPercentage

Use Data 
Source

Click the data group to report on. Click

• Projects to choose from all Projects 
defined for your Company

• Users to choose selected Agents, 
Supervisors, and Administrator 
accounts defined for your Company

• Users supervised by to report on 
Agents who are supervised by 
selected Supervisors or 
Administrators.

• Users from this workgroup to 
report on users in a particular 
Workgroup.

• Users from this department to 
report on selected Departments.

HistoryActions
ReportsAgentUtilization
CombinedDataSource
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Figure 5-22 Agent Utilization Report: Layout Tab

Figure 5-22. Agent Utilization Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 5-16

Field Description

Build Report Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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Figure 5-23 Add Report Definition: Regional Options Tab

Figure 5-23. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 5-17

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 5-24 Add Report Definition: Permissions Tab

Figure 5-24. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report.

• See page 14-10 for information about deleting a report.

Direct Dialing Statistics Reports
The Direct Dialing Statistics Report shows non-Workgroup calls 
where:

• An Agent dialed another Agent
• Agents called external numbers
• A caller dialed an Agent’s extension directly
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Figure 5-25 Direct Dialing Statistics Report

Figure 5-25. Direct Dialing Statistics Report

Report Elements

The following sections describe each element included in the following 
areas of the Direct Dialing Statistics Report:

• Agent Call Processing
• Summary
• Interaction Type

Note
CCA Supervisors viewing the Direct Dialing Statistics Report should 
bear in mind that this report reflects activity for the entire Company. 
Data presented includes all Agents in the selected Project or 
Workgroup (not just the Agents you supervise).
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Agent Call Processing

The Agent Call Processing area of the Direct Dialing Statistics Report 
shows the average length of time Agents spent in various phases of 
the Interaction.

Summary

The Summary area of the Direct Dialing Statistics Report shows 
overview data for Interactions received, and overview data for 
Interaction wait times.

Table 5-18Direct Dialing Statistics Report: Agent Call Processing Area

Item Description

Average Talk Time Average number of seconds Agents spent talking 
with callers.

Average Hold Time Average number of seconds Agents kept callers on 
Hold.

Average Process 
Time Per Call

Average number of seconds Agents spent 
processing a call, including talk time, hold time, and 
wrap up time.

Table 5-19Direct Dialing Statistics Report: Summary Area

Item Descriptions Table/Field

Total Interactions 
Received

Total number of Interactions 
received by your Company.

HistoryActions
ReportCallCenterKeyNoACD

Number of Times 
Interactions Went to 
Hold

Total number of voice 
Interactions placed on Hold at 
any time by an Agent.

HistoryActions
ReportCallCenterKeyNoACD

Duration of Interactions Total time Interactions spent in 
the system. Calculated as the 
difference between the time the 
Interaction was received by 
CCA and the conclusion of the 
Interaction.

HistoryActions
ReportCallCenterKeyNoACD
The Agent Profile and Productivity Reports 5-27



Interaction Type

The Interaction Type area of the Direct Dialing Statistics Report shows 
the number of Interactions of each media type handled by the selected 
Projects or Workgroups.

Table 5-20Direct Dialing Statistics Report: Interaction Type Area

Item Description Table/Field

Direct Inbound Number of calls placed by 
callers directly to a specific 
Agent. For example, CCA 
reports a caller using the 
Company Directory to reach a 
specific Agent as a Direct 
Inbound call.

Note:
If a Direct Inward Dialing 
number (a DNIS) has been 
set for an Agent (Options > 
Agents > Phone > Direct 
Inward Dialing) Direct 
Inbound calls will not be 
included in reports unless a 
billing Project is set for the 
Agent. 

Billing Projects can be set for 
Agents in two ways:
• Administration Manager > 

Options > Agents > 
Controls and Restrictions 
tab > Project Billing check 
box.

• Interaction Manager > 
Configuration dialog box > 
General tab > Project 
Billing check box.

HistoryActions
ReportCallCenterKeyNoACD
HasInbound

Direct Outbound Number of calls placed by 
Agents directly to an external 
phone number.

HistoryActions
ReportCallCenterKeyNoACD
HasOutbound

Inbound 
Extension

Number of calls received by 
Agents from other Agents.

HistoryActions
ReportCallCenterKeyNoACD
HasInEXT
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Creating a Direct Dialing Statistics Report

1. Click Reports > Agent Profile & Productivity > Direct Dialing 
Statistics.

2. Click Add.

Figure 5-26 Add Report Definition: Name Tab

Figure 5-26. Add Report Definition: Name Tab

Outbound 
Extension

Number of calls placed by 
Agents to other Agents

HistoryActions
ReportCallCenterKeyNoACD
HasOutExt

Total 
Interactions

Total number of direct dialed 
calls placed or handled by 
Agents.

HistoryActions
ReportCallCenterKeyNoACD

Table 5-20Direct Dialing Statistics Report: Interaction Type Area

Item Description Table/Field
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3. Complete the Name tab for your Direct Dialing Statistics Report.

4. Click Content.

Figure 5-27 Add Report Definition: Content Tab

Figure 5-27. Add Report Definition: Content Tab

Table 5-21

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Direct Dialing 
Statistics Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Direct Dialing Statistics Report definitions.
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5. Complete the Content tab.

6. Click Regional Options.

Figure 5-28 Add Report Definition: Regional Options Tab

Figure 5-28. Add Report Definition: Regional Options Tab

Table 5-22

Field Description

Include 
Statistics On

Check the elements to include in the report in the Include 
Statistics On area. Click All to include all elements, or click 
Clear to clear all the check boxes. See “Interaction Type” on 
page 5-28 for a description of each Interaction Type you can 
include in the report.

Using Data 
Source

Select one or all of your Projects.
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7. Complete the Regional Options tab.

8. Click Permissions.

Figure 5-29 Add Report Definition: Permissions Tab

Figure 5-29. Add Report Definition: Permissions Tab

9. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

Table 5-23

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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10. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Login by Groups of Users Report
The Login by Groups of Users Report shows the total time that 
Agents and Supervisors were logged into the Interaction Manager and 
Supervision Manager. See “Login by User Report” on page 5-39 to see 
the exact time each Agent signed into or out of the Interaction 
Manager or Supervision Manager.

Figure 5-30 Login by Groups of Users Report

Figure 5-30. Login by Groups of Users Report

Note: 

• Data is not calculated for a user until they log out of the 
Interaction Manager or Supervision Manager. Users that are 
presently logged in are excluded from the Summary Login 
Report. 

• In addition, users are included in the report only if they logged 
out on a day that falls within the requested report date range.
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Creating a Login by Groups of Users Report

1. Click Reports > Agent Profile & Productivity > Login by Groups of 
Users.

2. Click Add.

Figure 5-31 Add Report Definition: Name Tab

Figure 5-31. Add Report Definition: Name Tab

3. Complete the Name tab for your Login by Groups of Users Report.

4. Click Content.

Table 5-24

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Login by Groups 
of Users Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Login by Groups of Users Report definitions.
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Figure 5-32 Login by Groups of Users Report: Content Tab

Figure 5-32. Login by Groups of Users Report: Content Tab

5. Complete the Content tab.

6. Click Layout.

Table 5-25

Field Description

Include 
Statistics On

Click the data group to report on. Click

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.
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Figure 5-33 Login by Groups of Users Report: Layout Tab

Figure 5-33. Login by Groups of Users Report: Layout Tab

7. Complete the Layout tab.
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8. Click Regional Options.

Table 5-26

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.

Include Chart in the 
Report

Check Include Chart in the Report to include a 
graphical representation of the report information in 
the generated report. Under Select the Type of 
Chart, click the type of chart to include in your 
report. Verify the report layout in the Preview area.

Choose the number of items to include in the 
graphical portion of the report from the Select the 
number of items to display drop list.

Note: When making the selection of number of 
items to include in the graphical portion of the 
report, the Graph will create it’s own filter showing 
only the agents with the highest Log-in times. To 
remedy this, select a number corresponding with 
the total number of Agents assigned to the 
Company.
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Figure 5-34 Add Report Definition: Regional Options Tab

Figure 5-34. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 5-27

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 5-35 Add Report Definition: Permissions Tab

Figure 5-35. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

• See page 14-10 for information about deleting a report.

Login by User Report
The Login by User Report shows the total time that Agents and 
Supervisors were logged into the Interaction Manager and Supervision 
Manager.

• The Login Date and Login Time of each Agent session
• The Duration of each login session
• The Total length of time the Agent was logged into the Interaction 

Manager (sum of all session durations)
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Figure 5-36 Login by User Report

Figure 5-36. Login by User Report

Creating a Login by User Report

1. Click Reports > Agent Profile & Productivity > Login by User.

2. Click Add.
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Figure 5-37 Add Report Definition: Name Tab

Figure 5-37. Add Report Definition: Name Tab

3. Complete the Name tab for your Login by User Report.

4. Click Content.

Table 5-28

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Login by User 
Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Login by User Report definitions.
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Figure 5-38 Login by User Report: Content Tab

Figure 5-38. Login by User Report: Content Tab

5. Complete the Content tab.

6. Click Layout.

Table 5-29

Field Description

Using Data 
Source

Click the data group to report on. Click

• Users to choose selected Agents, Supervisors, and 
Administrator accounts defined for your Company

• Users supervised by to report on Agents who are 
supervised by selected Supervisors or Administrators.

• Users from this workgroup to report on users in a 
particular Workgroup.

• Users from this department to report on selected 
Departments.
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Figure 5-39 Login by User Report: Layout Tab

Figure 5-39. Login by User Report: Layout Tab

7. Complete the Layout tab.

8. Click Regional Options.

Table 5-30

Field Description

Build Report Include elements in your report by clicking the item 
to include in the Elements box, and then clicking 

 (or just click  to include all elements).

Arrange the order of the report columns by clicking 
an included element and then clicking  to move 
a column to the left or click  to move the column 
to the right.
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Figure 5-40 Add Report Definition: Regional Options Tab

Figure 5-40. Add Report Definition: Regional Options Tab

9. Complete the Regional Options tab.

10. Click Permissions.

Table 5-31

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 5-41 Add Report Definition: Permissions Tab

Figure 5-41. Add Report Definition: Permissions Tab

11. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

12. Click OK.

• See page 14-3 for information about viewing and printing a 
report.

• See page 14-10 for information about deleting a report.
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6

The Project Reports 6

Project Segments Report
The Project Segments Report provides a summary report of all Project 
Activity related to types of Interaction received by the Project, along 
with all Service Performance related Metrics, such as Speed to Answer, 
etc.
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Report Elements
The Project Segments Report has two primary Areas; Segment Events 
and Interaction Type Summary. 

The Information for Segment Events is presented in either area Totals 
and in an hour/minute/second format. While Information for 
Information Type Summary is presented in a Total number and 
Percentage of the Total format.

Below are the definitions for each of the Fields in both Areas.

Table 6-1 Segment Events Descriptions

Field Name Description Table/Field

Total Segments 
Received

Total Number of Segments Received 
by the Project

HistoryActions

Total Talk Time Total amount of Time that Agent spent 
on phone with Customer. Talk Time = 
Talk Time + Hold Time

HistoryActions

Average Talk Time Average Talk Time = Total Talk Time + 
Total Hold Time/Total Number of 
Segments

HistoryActions

Total Hold Time Total amount of time that Agents had 
Callers on Hold

HistoryActions

Average Hold 
Time

Average Hold Time = Total Hold 
Time/Total Number of Segments

HistoryActions

Total Wait to 
Answer Time

Total amount of time Callers spent 
waiting to be transferred to an Agent

HistoryActions

Average Speed of 
Answer

Total Amount of time in Queue/Total 
Number of Segments

HistoryActions

Longest Wait to 
Answer

The Highest amount of time a Caller 
Segment waited to be transferred to 
an Agent

HistoryActions

Shortest Wait to 
Answer

The Lowest amount of time a Caller 
Segment waited to be transferred to 
an Agent

HistoryActions

Total Wrap Up 
Time

Total Amount of time that Agents 
spent in “Wrap Up” state

HistoryActions

Average Wrap Up 
Time

Average Wrap Up Time= Total Wrap 
Up Time/Total Number of Segments

HistoryActions
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Table 6-2 Interaction Type Summary

Field Name Description Table/Field

Inbound Calls Total Number of Inbound Calls 
received by the Project

HistoryActions

Outbound Calls Total Number of Outbound calls made 
using the Project as the Billing Project

HistoryActions

Chat Total Number of Chats received by the 
Project

HistoryActions

Workgroup Email Total Number of Workgrouop E-Mail 
received by the Project

HistoryActions

Web Callback Total Number of Web Callbacks 
received by the Project

HistoryActions

Predictive Total Number of Predictive Calls 
routed to the Project

HistoryActions

Preview Total Number of Preview Calls 
generated by the Project

HistoryActions
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Creating an Project Segments Report

1. Click Reports > Projects > Project Segments Click Add.

Figure 6-1 Add Report Definition: Name Tab

Figure 6-1. Add Report Definition: Name Tab

2. Complete the Name tab for your Overdue Callbacks Report.

3. Click Content.

Table 6-3

Field Description

Report 
Name

Enter a name for this report. The name appears on each page of 
the report and in the Name column of the list of Overdue 
Callbacks Report definitions.

Description Enter a description of the information contained in this report, or 
some text that allows you to differentiate this report from other 
reports of this type. The description appears in the Description 
column of the list of Overdue Callbacks Report definitions.
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Figure 6-2 Overdue Callbacks Report: Content Tab

Figure 6-2. Overdue Callbacks Report: Content Tab

4. Complete the Content tab.

Table 6-4

Field Description

Inbound Calls Select Check Box to include all Inbound Calls received 
by the Project

Outbound Calls Select Check Box to include all Outbound Calls 
generated by Project

Chat Select Check Box to incude all Chats received by 
Project

Workgroup Email Select Check Box to include all E-Mail received by 
Project

Web Callback Select Check Box to include all Web Callbacks received 
by Project

Predictive Select Check Box to include all Predictive Calls routed 
to Project

Preview Select Check Box to include all Preview Calls made by 
Project
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5. Identify Data Source. Select one or All Projects to report on.

6. Click Layout.

Figure 6-3 Overdue Callbacks Report: Layout Tab

Figure 6-3. Overdue Callbacks Report: Layout Tab

7. Click Regional Options.
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Figure 6-4 Add Report Definition: Regional Options Tab

Figure 6-4. Add Report Definition: Regional Options Tab

8. Complete the Regional Options tab.

9. Click Permissions.

Table 6-5

Choose... To display...

Company Default 
Time Zone

All times using the indicated time zone set for the 
Company.

User Time Zone All times using the indicated time zone set for your 
workstation.

Report Language All report contents in the language you choose.

Company Default 
Date Format

All dates using the indicated format set for the Company.

User Defined 
Date Format

All dates using the indicated format set for your 
workstation.
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Figure 6-5 Add Report Definition: Permissions Tab

Figure 6-5. Add Report Definition: Permissions Tab

10. Check the Supervisors to grant permission to view and print the 
report. Supervisors you do not check do not see the report 
definition in the Supervision Manager. Click All to include the entire 
list, or click Clear to clear all selections.

11. Click OK.

• See page 14-3 for information about viewing and printing a 
report. 

See page 14-10 for information about deleting a r
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